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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2006-2007 Hewlett-Packard Development Company, L.P.

This product includes i-net OPTA software, which is © Copyright 2002-2006 i-net software 
GmbH, Berlin, Germany.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

AMD is a trademark of Advanced Micro Devices, Inc.

HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on all HP 9000 
computers are Open Group UNIX 95 branded products.

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the 
United States and other countries.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the U.S. and other countries.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Support

You can visit the HP software support web site at:

http://www.hp.com/managementsoftware/support 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many 
also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html 
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Documentation Roadmap

Figure 1 on page 10 shows the documentation roadmap for HP Operations 
Dashboard Operations View. This roadmap presents a suggested order for 
reading the manuals available with Operations View:

1 Use the Installation Guide to install the product.

2 Follow the path for Operations View.

a Use the Operations View Quick Start Guide to carry out the tutorial.

b Read the “Essential Concepts” chapter of the Operations View 
Administrator Guide to understand the concepts of working with 
portlets and portal servers.

c Use the Operations View Administrator Guide to configure and 
maintain the product. This guide provides high-level instructions for 
the common tasks when working with the supplied Operations View 
portlets 

d If you are migrating from HP OpenView Service Information Portal to 
Operations View, use the Operations View Migration Guide to 
complete this task. The Operations View Administrator Guide refers 
you to the Operations View Migration Guide at the appropriate point 
in the portal view implementation process.

e Reference the integration guides as needed for specific details on each 
supported HP OpenView management product. The Operations View 
Administrator Guide refers you to the integration guides at the 
appropriate points in the portal view implementation process.
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Figure 1 Operations View Documentation Roadmap



11

HP Operations Dashboard Manuals

Table 1 describes the HP Operations Dashboard manual set. These documents 
are provided in Adobe Acrobat (.pdf) format and can be found in the following 
directories:

• After HP Operations Dashboard installation, in the following directory on 
the HP Operations Dashboard management station:

— Windows: <install_dir>\paperdocs\dashboard\

— UNIX: /opt/OV/paperdocs/dashboard/

• On the product DVD-ROM in the following directory:

— Windows: \Docs\

— UNIX: /Docs/

For information on how to obtain the most recent documents, see 
Documentation Updates on page 15.

Table 1 HP Operations Dashboard Documentation

Document Title and Filename Main Topics

Installation Guide
Installation.pdf

Installing and uninstalling HP Operations 
Dashboard

Migration Guide
Migration.pdf

• Overview of migrating from 
HP OpenView Service Information Portal 
(SIP) version 3.2 to Operations View

• SIP and Operations View comparison
• Migration use models
• Using the Operations View Migration 

Wizard
• Manual steps for migration
• Jetspeed user migration for RealTime 

Health View and Operations View
• Troubleshooting



12

Operations View Quick Start Guide
opview/Quick_Start.pdf

• Running the Operations View 
demonstration portal view

• Operations View tutorial

Operations View Administrator Guide
opview/Administration.pdf

• Essential concepts
• Planning roadmap for using Operations 

View
• Connecting Operations View to 

management products
• Configuring Operations View portlets
• Configuring Operations View data filters
• Deploying a portlet application
• Troubleshooting

Operations View Integration Guide: NNM
opview/NNM_Integration.pdf

• Connecting Operations View to 
HP OpenView Network Node Manager 
(NNM)

• Configuring the NNM portlets
• Customizing the NNM portlets
• Filtering NNM data
• Troubleshooting

Operations View Integration Guide: OVO and 
OVSN
opview/OVO_OVSN_Integration.pdf

• Connecting Operations View to 
HP OpenView Operations (OVO) and 
HP OpenView Service Navigator (OVSN)

• Configuring the OVO and OVSN portlets
• Customizing the OVO and OVSN portlets
• Filtering OVO and OVSN data
• Troubleshooting

Operations View Integration Guide: OVIS
opview/OVIS_Integration.pdf

• Connecting Operations View to 
HP OpenView Internet Services (OVIS)

• Configuring the OVIS portlets
• Customizing the OVIS portlets
• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Integration Guide: OVPM
opview/OVPM_Integration.pdf

• Connecting Operations View to 
HP OpenView Performance Manager 
(OVPM)

• Configuring the OVPM portlets
• Customizing the OVPM portlets
• Filtering OVPM data
• Troubleshooting

Operations View Integration Guide: OVSD, 
OVPI, and OVR
opview/OVSD_OVPI_OVR_Integration.pdf

• Connecting Operations View to 
HP OpenView Service Desk (OVSD), 
HP OpenView Performance Insight 
(OVPI), and HP OpenView Reporter 
(OVR)

• Configuring the OVSD, OVPI, and OVR 
portlets

• Customizing the OVSD, OVPI, and OVR 
portlets

• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Online Help

Operations View supplies the following graphical interfaces for portal and 
portlet configuration:

• Operations View Administrator Tool

• Operations View Migration Wizard (available from the Administrator 
Tool)

Each of the Operations View graphical interfaces includes online help files 
that explain that interface.

• To access the top level of the help content for each interface, use the 
commands on the Help menu.

• To access context-specific help information in the Operations View 
interfaces, click Help within the window for which you want more 
information.
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of 
the software

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.



16

Documentation Conventions

The Operations View documentation uses the following conventions:

Table 2 HP Operations Dashboard Documentation Conventions

Symbol Meaning

<install_dir> (Windows only.) The HP OpenView application directory. This 
directory contains all of the HP Operations Dashboard files. 
The default location is:
C:\Program Files\HP OpenView\

<data_dir> (Windows only.) The HP OpenView data directory. This 
directory contains product configuration and data files. The 
default location is:
C:\Program Files\HP OpenView\data

<portlet_app_dir> The top-level directory for a deployed portlet application. This 
directory has the same name as the portlet application. The 
location of this directory depends on the installation platform 
and the portal server.
• Jetspeed on Windows:

<install_dir>\nonOV\dashboard\jetspeed\2.1\webapps

• Jetspeed on UNIX:
/opt/OV/nonOV/dashboard/jetspeed/2.1/webapps

• BEA WebLogic on Windows (default):
<bea_install_dir>\user_projects\applications

• BEA WebLogic on UNIX (default):
<bea_install_dir>/user_projects/applications

<bea_install_dir> is the BEA WebLogic directory.

A note that describes special information pertaining to the 
current topic.

A tip that provides an alternate way to address the current 
topic.

A caution that indicates a potential problem to avoid.
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1 Introduction to the OVO and OVSN 
Integrations

The Messages and Service Navigator portlets provided with HP OpenView 
Dashboard Operations View integrate with two HP OpenView products: 
HP OpenView Operations for UNIX (OVOU) and HP OpenView Operations 
for Windows (OVOW). This manual refers to both products collectively as OVO 
and makes distinctions between the products only when necessary.

OVOU and OVOW both provide central operations and problem-management 
for distributed multi-vendor environments. OVO provides:

• Central message-management for consolidation, simplification and 
automation of message processing.

• Central monitoring for proactive problem resolution.

• Central problem-management for problem notification, resolution, and 
tracking.

• Central control for efficient management.

HP OpenView Service Navigator (OVSN) is an add-on product for OVOU that 
enables you to manage an IT environment while focusing on the IT services. 
The same feature set is available within the OVOW product. For information 
about configuring OVO, see the documentation provided with that product. 
For information about configuring services within OVOW, see the OVOW 
online help. For information about configuring services within OVSN, see the 
HP OpenView Service Navigator Concepts and Configuration Guide. All 
HP OpenView manuals are available online at the web site: http://
ovweb.external.hp.com/lpe/doc_serv
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You can view the data that OVO and OVSN collect through the Operations 
View Messages portlet. See The Messages Portlet for Operations View on 
page 19.

You can view the data that OVSN collects through the Operations View 
Service Navigator portlets:

• Service Browser portlet

• Service Cards portlet

• Service Graph portlet

• Service Health portlet

See The Service Navigator Portlets for Operations View on page 20.
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The Messages Portlet for Operations View

If OVO is configured and running within your management environment, 
Operations View can display OVO message information through the Messages 
portlet.

In Operations View, you control access to three possible layers of information 
within the Messages portlet:

• Summary
The summary page contains a high-level list of the type and number of 
messages received within one or more message categories. These 
categories correspond to the standard OVO message attributes: Nodes, 
Services, Objects, Applications, and Message Groups. If you have 
configured custom OVO message attributes within OVOU, they cannot be 
used as Operations View message categories. However, custom message 
attributes are displayed on the details page. The messages are filtered 
according to your Operations View configuration.

• Drill-down to list page
Accessed through links on the summary page, the list page contains a 
complete list of messages received within a specific category, filtered 
according to your Operations View configuration. In the Messages portlet, 
you can affect the state of these messages by changing the ownership of a 
message or changing its acknowledgement (ack/unack).

• Drill-down to details page
Accessed through links on the list page, the details page presents all 
known information about a specific message, including custom attributes 
configured in OVOU. On this page you can also affect the specific message 
by adding annotations, modifying the text and/or severity, and initiating 
pre-configured automatic and/or operator-specific actions.

See Chapter 3, Working with the Messages Portlet for more information.
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The Service Navigator Portlets for Operations View

The integration of OVSN and the service-related parts of OVOW into 
Operations View provides up-to-date information about managed services to 
your end users.

The following OVSN portlets are included in Operations View:

• Service Browser portlet

A table-like view of services, providing links to details about specific 
services. See Chapter 4, Working with the Service Browser Portlet for 
more information.

• Service Cards portlet

A business-card view of services, providing links to details about specific 
services. See Chapter 5, Working with the Service Cards Portlet for more 
information.

• Service Graph portlet

A hierarchical view of the OVSN configuration settings for a particular 
service. See Chapter 6, Working with the Service Graph Portlet for more 
information.

• Service Health portlet

A gauge-like view that shows aggregated service status and provides links 
to details about specific services. See Chapter 7, Working with the Service 
Health Portlet for more information.
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Interaction Between OVO/OVSN and Operations View

Operations View running on any supported operating system can integrate 
with multiple OVO management servers, regardless of the OVO operating 
system. The Installation Guide includes information about supported OVO 
and OVSN versions and required patches.

You can install Operations View and OVO/OVSN in any order; however, you 
must perform at least minimum OVO/OVSN configuration before you can 
configure the Messages and Service Navigator portlets. For information on 
configuring OVO and OVSN, see the documentation that came with those 
products.

Before using the Messages and Service Navigator portlets, configure 
Operations View and OVO/OVSN to communicate with each other. See 
Chapter 2, Configuring the Operations View Connection to OVO and OVSN.

Figure 2 on page 22 illustrates how the Messages portlet communicates with 
OVOU.

Figure 3 on page 23 illustrates how the Service Navigator portlets 
communicate with OVSN.

Figure 4 on page 24 illustrates how the Messages and Service Navigator 
portlets communicate with OVOW.
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Figure 2 Communication Process for the Messages Portlet 
Displaying Data from OVO for UNIX 
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Figure 3 Communication Process for the Service Navigator Portlets 
Displaying Data from OVSN for UNIX
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Figure 4 Communication Process for the Messages Portlet 
Displaying Data from OVO for Windows 
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Version 2.10 HP Operations Dashboard Operations View Integration Guide: OVO and OVSN
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2 Configuring the Operations View 
Connection to OVO and OVSN

You must establish communication between HP OpenView Dashboard 
Operations View and your HP OpenView Operations (OVO) management 
servers. If HP OpenView Service Navigator (OVSN) is installed on the OVO 
management server, additional configuration work is required. Perform the 
following configurations on each OVO management server and on the 
Operations View server.

On the OVO for UNIX Management Server

The Messages portlet communicates with OVOU through its listener service. 
The Messages and Service Navigator portlets communicate with OVSN 
through its opcsvcterm service. In addition to these mechanisms, the OVO 
Messages portlet and Service-related portlets require HP OpenView 
Interconnect (OVI) to implement the optional Ack/Own functionality for an 
OVOU management station. OVI is an integration component that must be 
installed on the OVOU management server.

The steps for configuring the listener service and the opcsvcterm service are 
detailed here. The installation procedure for OVI with an OVOU/OVSN 
management server is found in Installing HP OpenView Interconnect on 
page 40.

Because the opcsvcterm service provides read-write access to the 
OVSN database, it is recommended that access to this service be 
limited to trusted hosts with the need to access it, such as the 
Operations View server.
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Perform the following steps on each OVOU management server in your 
network:

1 Verify that you are using a version of OVO that is supported by 
Operations View. Refer to the Installation Guide for the list of supported 
product versions.

2 In any text editor, open the /etc/services file on each OVO management 
server.

3 Verify that the following lines are present:

• For OVOU:
listener 1521/tcp #Oracle Net8 listener

• For OVSN: 
opcsvcterm 7278/tcp # Service engine remote access

If not, consult the documentation that comes with OVOU and OVSN to 
determine how to configure remote access settings. Note that the port 
numbers specified in the Operations View Administrator Tool (see On the 
Operations View Server on page 36) and in this /etc/services file must 
be identical.

4 In any text editor, on each OVSN management server, open the /etc/
inetd.conf file.

5 Verify that the following line is present, and if not then add it:

• For OVSN: 

opcsvcterm stream tcp nowait root /opt/OV/bin/OpC/opcsvcterm opcsvcterm

6 Trigger the inetd service to re-read the configuration files.

• HP-UX: As superuser, run: /etc/inetd -c

• Solaris: Send the hangup signal to the currently running inetd 
process.
Run: kill -1 current_inetd_PID

7 If you are running OVOU 6.0.x, install the following patch:

• HP-UX: PHSS_24264 or later.

• Solaris: ITOSOL_00101 or later.
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Optional Steps on UNIX

If SNVP is installed, the performance of the Service Navigator portlets might 
not be satisfactory. In this case follow these steps to improve performance:

1 On the OVSN management server open the /etc/services file using any 
text editor, and add the following line to the end of the file:

cadmsnd_opv 7281/tcp # Common Admin Service Navigator Deployment for 
Operations View

The port number can be different, but ensure that the same port number 
is specified using the Administrator Tool as the value of Service Navigator 
Read Port for this OVO station. See Management Station Settings on 
page 36.

2 Open the /etc/inetd.conf file using any text editor, and add the 
following line to the end of the file.

cadmsnd_opv stream tcp nowait root /opt/OV/bin/OpC/cadmsnd cadmsnd

3 Trigger the inetd service to re-read the configuration files.

• HP-UX: As superuser, run: /etc/inetd -c

• Solaris: Send the hangup signal to the currently running inetd 
process.
Run: kill -1 current_inetd_PID

On the OVO for Windows Management Server

The Messages and Service Navigator portlets utilize a .NET web application 
to communicate with OVOW management servers. In addition to the .NET 
web application, the Messages and Service Navigator portlets require 
HP OpenView Interconnect (OVI) to implement the optional Ack/Own 
functionality for an OVOW management station. OVI is an integration 
component that must be installed on a Windows computer other than the 
OVOW management server. If Operations View is installed on a Windows 
computer, the OVI component can also be installed on that computer.

The installation procedure for the web application is detailed below. The 
installation procedure for OVI with an OVOW management server is found in 
Installing HP OpenView Interconnect on page 40.
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Installing the .NET Integration Component

The .NET implementation uses the original naming scheme, ovow2sip, which 
reflects the fact that it is backward compatible with HP OpenView Service 
Information Portal, version 3.2.

The ovow2sip.NET mechanism provides a full .NET integration component 
facilitating communication between Operations View and the OVOW 
management server. It has a semi-automated installation procedure, 
requiring a few manual configuration steps.

ovow2sip.NET requires that OVOW be installed and running. In addition, the 
ovow2sip.NET installation requires the Microsoft .NET 1.1 Framework to be 
installed, including the ASP.NET components.

On Windows 2003 Server installations, Microsoft .NET Framework is 
installed with the operating system, but the ASP.NET component might not 
be installed or enabled. Instructions for installing the Windows ASP.NET 
component on a Windows 2003 Server and enabling it can be found in the 
Microsoft ASP.NET Home under System Requirements at the following URL: 
http://msdn.microsoft.com/asp.net/support/sysreqs/default.aspx That 
page also includes download and installation instructions for the NET 
Framework for Windows XP Professional and Windows 2000 Server.

If multiple versions of the Microsoft .NET Framework have been installed, it 
is referred to as a “side-by-side” installation. Some side-by-side installations 
result in an improperly configured ASP.NET session state service 
(aspnet_state). In addition, the Service Pack 1 for Windows 2003 Server and 
Service Pack 2 for Windows XP can cause the ASP.NET session state service 
to become unregistered. This seems to happen when the service packs are 
installed under Windows Update. To rectify this situation, re-establish the 
ASP.NET session state service with the following command:

C:\WINDOWS\Microsoft.NET\Framework\<version>\
aspnet_regiis.exe –ir

where <version> is the most recent installed version of the .NET Framework

http://msdn.microsoft.com/asp.net/support/sysreqs/default.aspx
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1 Verify that you are using a version of OVO that is supported by 
Operations View. Refer to the Installation Guide for the list of supported 
product versions.

2 Provide to the OVOW administrator the following installation package.

<install_dir>\misc\dashboard\opview\integrations\ovo\
ovow2sip.NET.msi

3 To the OVOW administrator: Running the ovow2sip.NET.msi installer 
will create a web application and its associated virtual directory on the 
OVOW management server. Run the MSI installer and follow the 
directions provided. Enter the name of the virtual directory to use 
(default: ovow2sip.NET). If you enter a relative path, the resulting 
directory will end up under the IIS default web folder, typically 
C:\inetpub\wwwroot (make note of the virtual directory name you enter, 
as it will need to be provided to the Operations View administrator upon 
successful installation).

When this initial installation process is completed, the installer will have 
created a virtual directory containing a few files and two sub folders: bin 
and controlService. The controller service contained in the 
controlService folder must be installed before the web application can 
be started (see step 3 below).

4 To the OVOW administrator: Install the controller service. The installer 
for the service is in the controlService sub folder in the virtual directory 
you just created. Open a file browser (such as Windows Explorer) on the 
folder (for example, if you used the default location, the folder would be 
named C:\inetpub\wwwroot\ovow2sip.NET\controlService), and 
launch the O2SControlServiceSetup.msi application found there. Follow 
the instructions for installation, making note of the install location you 
choose (it will be needed in the next step).

If you are unsure of the location of the default web folder for IIS, it 
can be determined by visiting

Start:Control Panel:Administrative Tools:Internet Services 
Manager

, then expanding the left control pane until the "Default Web Site” 
item is visible. Right-click the item and select "Properties" from the 
resulting menu. Select the "Home Directory" tab in the "Default 
Web Site Properties" dialog. The default web folder is found in the 
"Local Path:" text area.
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5 To the OVOW administrator: During the controller service installation, 
you were prompted to enter a user name and password to be used when 
starting and stopping the web application. If the values entered are 
correct, you can skip this step. If corrections are needed, you can make 
them after the installer completes by directly editing the configuration file 
used by the controller service. The configuration file is named 
O2SControlConfig.xml and is contained in the control service install 
folder created in the previous step. It contains 6 entries that might need 
modification:

• Host (default: <local system name>) - If the local system name is 
not accessible to the service (which is run under the LocalSystem 
account), replace this entry with the name of the available web server, 
possibly the IP address or fully qualified domain name.

• VirtualDirectory (default: <virtual directory entered during 
install>) - If you installed in a location other than the default, enter 
that location here.

• User (default: <username entered during install>) - Ensure the value 
here is a user with read and write access rights to OVOW (typically, 
members of the HP-OVE-ADMINS group or another group with those 
rights).

• Password (default: <password entered during install>) - Enter the 
appropriate password for the specified user.

• Timeout (default: “1800”) - Enter the number of seconds the service 
can wait while ovow2sip.NET initializes.

• TraceLevel (default: “2”) - Enter the numeric level for tracing (0 is 
none, 6 is most verbose). If tracing is turned on, the trace file 
O2SLogFile.txt will be written into the default temp directory 
configured for the ASP.NET default user. Typically, this is either 
C:\Documents and Settings\MachineName\ASPNET\Local 
Settings\Temp or C:\Windows\Temp

6 To the OVOW administrator: After the configuration steps are complete, 
ensure that the service is started. If you chose not to start the service 
automatically after the install completed, you will need to start the service 
now. This can be accomplished by either rebooting the OVOW 
management server to start the service automatically, or by following the 
procedure detailed below to start the service manually.
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To manually restart the service:

a Open:

Start:Control Panel:Administrative Tools:Services

b Select HP OpenView ovow2sip.NET Controller

c Start the service.

Troubleshooting hints: If the service fails to start, it might be that 
OVOW or one of the other dependent services is not currently installed 
or running, or the user/password combination you configured in step 4 
is incorrect or does not have the necessary OVOW access rights.

Make sure that OVOW is installed and operational before attempting 
to restart the service. In addition to the OVOW services, 
ovow2sip.NET is dependent on the ASP.NET State (aspnet_state) 
and Windows Management Instrumentation (winmgmt) services.

Depending on the number of services and messages contained in 
the OVOW database, it can take seconds or minutes before 
ovow2sip.NET can build its internal caches and deliver useful 
information to the Operations View server. Users of the Messages 
and Service Navigator portlets will see “Data Unavailable” 
messages when those portlets are accessed during this startup 
period.

If multiple versions of the Microsoft .NET Framework have been installed, it 
is referred to as a “side-by-side” installation. Some side-by-side installations 
result in an improperly configured ASP.NET session state service 
(aspnet_state). In addition, the Service Pack 1 for Windows 2003 Server and 
Service Pack 2 for Windows XP can cause the ASP.NET session state service 
to become unregistered. This seems to happen when the service packs are 
installed under Windows Update. To rectify this situation, re-establish the 
ASP.NET session state service with the following command:

C:\WINDOWS\Microsoft.NET\Framework\<version>\
aspnet_regiis.exe –ir

where <version> is the most recent installed version of the .NET Framework
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A check for the existence of the dependent services is performed 
during installation. However, if a dependent service is removed after 
the initial installation, the Control Service will fail to start. The 
dependent services must be restored before the Control Service will 
operate properly.

Errors are logged in the file O2SControlServiceLog.txt under the 
control service application directory you specified in step 3. The 
default location for the application directory is

C:\Program Files\HP OpenView\ovow2sip.NET Control Service

If the O2SControlServiceLog.txt contains errors marked by 401 - 
Unauthorized, you might not have configured the user/password 
correctly in step 4, or might have forgotten to set up appropriate 
authentication in step 3.
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7 To the OVOW administrator: Provide the Operations View administrator 
with the following information:

• The path to the ovow2sip.NET web application. The path is comprised 
of the virtual directory specified during installation with
/ovow2sip.aspx appended. For example, if the virtual directory 
specified during installation was myOvow2sip.NET, the path is 
myOvow2sip.NET/ovow2sip.aspx.

• The port on which the web server is running on the OVOW 
management server, and an indication of whether the web server is a 
secure web server.

• A user name and password needed to access OVOW management 
server.

8 To the Operations View administrator: Using the values provided in 
Step 7, configure an OVOW management server using the Administrator 
Tool, as described in On the Operations View Server on page 36.
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On the OVSN Management Server

If OVSN is installed and configured on your OVO/OVSN management server, 
follow these steps:

1 Verify that you are using a version of OVO that is supported by 
Operations View. Refer to the Installation Guide for the list of supported 
product versions.

2 Log on as root on the system where OVSN is installed.

3 If you are running OVOU 6.0x, install the following patch:

•  Solaris: ITOSOL_00117 or later.

• HP-UX: PHSS_24741 or later. 

4 Ensure that the OVSN processes are running. At the command prompt, 
type:

/opt/OV/bin/OpC/opcsv -start

On the Operations View Server

Configure one or more OVO management stations from the Operations View 
server.

Management Station Settings

To establish communication between Operations View and OVO, follow these 
steps to define the OVO management server configuration settings:

1 In the scoping pane of the Operations View Administrator Tool, navigate 
to the Management Stations folder.

If you are configuring Operations View to communicate with multiple OVO 
management servers, the system name appearing closest to the top of the 
Management Stations folder in the Administrator Tool scoping pane becomes 
the default OVO management server. Therefore, configure the station that 
you want to be the default first.
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2 To add a new OVO management station, right-click Management Stations, 
click New Management Station, and then type the fully-qualified host name 
of the OVO management station.

To add OVO settings to an existing management station, select that 
management station in the scoping pane.

3 In the editor pane, select OVO is Installed on this System.

The OVO tab becomes available.

4 On the OVO tab, select the operating system type for the version of OVO 
running on the management station that you identified in Step 2.

The configuration options depend on the operating system type.

• For OVOU, go to Step 5.

• For OVOW, go to Step 6.

5 For OVOU, set the configuration options for this OVOU management 
station, and then go to Step 7:

• OVO 8.0 or later: Select this check box if the OVO on this management 
station is version 8.0 or later.

• Service Navigator is installed: Select this check box if OVSN in 
installed on this OVO management station.

• In the General Settings area, specify the following settings:

— Minimum Connections: Minimum number of connections to store 
in a pool shared by all Messages portlet instances when 
connecting to Oracle.

— Maximum Connections: Maximum number of connections to store 
in a pool shared by all Messages portlet instances when 
connecting to Oracle.

— Maximum Cached Statements: Maximum number of statements 
to cache in the Messages portlet.

• If OVSN is installed, also specify the OVSN ports:

— Service Navigator Notify Port: The TCP port to use for listening to 
changes in the service tree from OVSN. The default port is 7278.

Selecting this check box makes the settings for the OVSN ports 
available.
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— Service Navigator Read Port: The TCP port to use for reading the 
service tree from OVSN. The default port is 7278. If SNVP is 
installed on the OVOU management station and the steps for 
setting up another daemon have been followed (see Optional Steps 
on UNIX on page 29), then that port number should be specified 
here.

• In the Database Settings area, specify the following settings:

— Database Host: The host on which the Oracle database resides. 
Leaving this field blank indicates that the OVOU management 
server is the Oracle database host. Specify this value only if 
OVOU was configured for remote database access.

— Database Port: The Oracle TCP port to connect to for remote 
access to the OVOU database. The default port is 1521.

— Database Name: The Oracle database name (SID) that is assigned 
during installation of OVOU. The default is openview. 

— Database User: The Oracle user name for Operations View to use 
when logging in to the Oracle database. 

— Database Password/Confirm Database Password: The password 
for Operations View to use when logging in to the Oracle database.

6 For OVOW, set the configuration options for this OVOW management 
station, and the go to Step 7:

• In the HTTP Related area, specify the following settings:

— Access method: Select whether to use HTTP or HTTPS for 
communicating with OVO.

— Web server port: Specify the port that the OVO web server uses.

For HTTP, the default port is 80.

For HTTPS, the default port is 443.

— User Name: A user name required to access a virtual directory 
that requires authentication. If the virtual directory entered in the 
OVO URL field requires authentication, the User Name and 
Password entries are required.

— Password/Confirm Password: The password required for the above 
User Name.

• In the General Settings area, specify the following settings:
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— OVO Language: The language used by the OVOW management 
server. As of OVOW 7.21, only English and Japanese are 
supported.

— OVO URL: The path to the installed OVOW integration 
component provided by the OVOW administrator. The default is 
ovow2sip.NET/ovow2sip.aspx.

— SN Polling Interval: The amount of time between polls of current 
service state. The default is 600 seconds.

7 Click Save.

8 Repeat Step 2 though Step 7 for each OVIS management station with 
which Operations View should communicate.
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Installing HP OpenView Interconnect

This section describes how to install the HP OpenView Interconnect (OVI) 
package. The Messages and Service Navigator portlets use OVI to perform 
actions (Ack/Own) on messages.

• To perform actions on messages from OVOU/OVSN, you must install the 
OVI package on the OVOU management server.

• To perform actions on messages from OVOW you must install the OVI 
package on a Windows computer other than the OVOW management 
server.

Installing OVI on UNIX

To install OVI on the UNIX operating system, follow these steps:

1 Log on to the OVO Unix computer as user root.

2 Insert the HP OpenView Dashboard DVD-ROM into the DVD drive.

3 Mount the DVD.

4 Change the working directory to the dvdrom directory using the cd 
command.

5 Start the install script by typing:

./dashboard_opview_ico_integration_2.00.000_setup.bin

6 On Introduction page appears, click Next.

7 The license agreement appears. If you agree with the license statement 
select the I Accept the Terms of the License Agreement check box, and 
then click Next.

8 On the Pre-Install Summary page, click Install to start the installation.

9 After the install completes, you can optionally configure a port for OVI to 
listen on as described in Configuring the OVI Port Number on page 42.

10 Run the following command to start OVI:

/opt/OV/lbin/ICO/ICO.sh -b -env /var/opt/OV/conf/ICO_OpView/ICO_OpView.env
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Installing OVI on Windows

To install OVI on the Windows operating system, follow these steps:

1 Log on to the Windows computer as a user with administrator privileges.

2 Disable any anti-virus software (including script blocking) running on this 
computer.

3 Insert the HP OpenView Dashboard DVD-ROM into the DVD drive.

4 The HP OpenView Installer should start automatically and display the 
Introduction page. Close this window and browse the DVD drive using 
Windows Explorer. In the top-level directory on the DVD drive, 
double-click dashboard_opview_ico_integration_2.00.000_setup.exe.

5 On Introduction page appears, click Next.

6 The license agreement appears. If you agree with the license statement 
select the I Accept the Terms of the License Agreement check box, and 
then click Next.

7 On the Pre-Install Summary page, click Install to start the installation.

8 During installation, enter the name of the OVOW management server. 
Enter the hostname of the OVOW management server that you plan to 
integrate with Operations View.

9 The ICO_OpView service is installed and started automatically. This 
service listens on port 8081 for any requests from the OVO portlets in 
Operations Viewto execute on the OVOW management server.

10 After the install completes, you can optionally configure a different port 
for OVI to listen on as described in Configuring the OVI Port Number on 
page 42.
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Configuring the OVI Port Number

By default the ICO_OpView service listens on port 8081. To change this port 
to any other value, follow these steps:

1 In any text editor, open the following file:

• Windows: <data_dir>\conf\ICO_OpView\
ResponderProxyPluglet_OpView.http.config

• UNIX: /var/opt/OV/conf/ICO_OpView/
ResponderProxyPluglet_OpView.http.config

2 Look for the line <serverPort>8081</serverPort> and change the port 
number to the preferred value.

3 Restart OVI:

• Windows:

— Click Start→ Control Panel→ Administrative Tools→ Services to open 
the Services window.

— Right-click on the ICO_OpView service, and then click Restart.

• UNIX:

— Stop OVI:

/opt/OV/lbin/ICO/ICO.sh -stop -env /var/opt/OV/conf/ICO_OpView/ICO_OpView.env

— Start OVI:

/opt/OV/lbin/ICO/ICO.sh -b -env /var/opt/OV/conf/ICO_OpView/ICO_OpView.env

4 Verify that OVI is running before attempting to deploy Messages or 
Service Navigator portlets. If OVI is not running, the Ack/Own features 
will not work properly.
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OVO Ports for Operations View

The Operations View server to OVO management server communication can 
go through a firewall. The ports that need to be opened through the firewall to 
gather data for the Messages and Service Navigator portlets are specified on 
the OVO tab of the management station configuration settings in the 
Administrator Tool (see On the Operations View Server on page 36).

Table 3 Port Requirements for Messages and Service Navigator Portlets

Server Product Protocol Default Port Configuration Location

OVO for UNIX OVO DB 1521 On the Operations View server, use the 
Administrator Tool to configure protocol 
and port (OVO tab for management 
stations).

OVO for Windows http 80

https 443

Table 4 Port Requirements for OVSN on Unix

Protocol Default Port Configuration Location

opsvcterm 7278 This service is available only if the OVSN add-on is 
installed on the OVO management server.
On the Operations View server, use the 
Administrator Tool to configure “Service Navigator 
Notify Port” port (OVO tab for management 
stations).

cadmsnd 
(optional)

7281 This service is available only if SNVP is installed on 
the OVO management server and a daemon is 
configured as described in Optional Steps on UNIX 
on page 29.
On the Operations View server, use the 
Administrator Tool to configure “Service Navigator 
Read Port” port (OVO tab for management stations).
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Table 5 Port Requirements for OVI

Protocol Default Port Configuration Location

ovi 8081 This port will be in use if an OVI station has been 
installed and configured to enable the Ack/Own 
features in the Messages or Service Navigator 
portlets.
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Running in Languages Other Than English

Any language that can be displayed within the UTF-8 codeset can be 
displayed through Operations View.

Configuring Operations View to Access UTF-8 Data From OVO/
OVSN

For OVOU, no additional configuration tasks are required to allow Operations 
View to access non-ASCII data from OVO/OVSN (provided that you have 
completed the steps in the previous sections of this chapter).

For OVOW, if an OVOW management server is running in a language that 
uses non-ASCII characters, change the OVO Language field for the OVOW 
management server configured in Operations View.

After the OVO Language field is set to Japanese, the portal server 
automatically translates OVO message data into Shift JIS characters.

1 In the scoping pane of the Operations View Administrator Tool, expand 
the Management Stations folder, and select the management station to 
modify.

2 In the editor pane, on the OVO tab, type the appropriate value into the 
OVO Language field.

3 Click Save.

Getting Japanese Node Lists and Service Lists from OVO for 
Windows

When setting up a customer model that segments the OVOW data by user, you 
might need to determine which nodes and services to add to the customer 
model (explained in Manually Creating Node List and Service List Filters on 
page 107). 
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To generate node list and service list filters in Japanese, in a web browser on 
the OVOW management server, run the ovow2sip.aspx application with the 
lang=japanese parameter, as shown here:

ovow2sip.aspx?lang=japanese&query=ListNodes

ovow2sip.aspx?lang=japanese&query=ListServices

ovow2sip.aspx?lang=japanese&query=ListServices&includeDisplay
=true



Configuring the Operations View Connection to OVO and OVSN 47

Version 2.10 HP Operations Dashboard Operations View Integration Guide: OVO and OVSN

HTTPS Support

The Operations View server to OVO management server communication 
cannot be configured to use the secure hypertext transfer protocol (HTTPS) at 
this time.
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3 Working with the Messages Portlet

HP OpenView Dashboard Operations View provides the Messages portlet for 
integrating with HP OpenView Operations (OVO).

This chapter describes how to create, configure, use, and customize the 
Messages portlet. For an overview of the portlet’s functionality, see Chapter 1, 
Introduction to the OVO and OVSN Integrations.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Messages 
Portlet on page 50.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Messages Portlet on 
page 51.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Messages Portlet on page 54.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Messages Portlet on page 56.
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Creating the Messages Portlet

Use the Administrator Tool to create the Operations Messages portlet within 
an existing portlet application.

To create the Messages portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVOMessages from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Messages Portlet

For information on the Operations Messages portlet configuration options, 
click Help at the bottom of the editor pane to view the online help page.

To configure the default settings for the Messages portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Messages portlet (named OVOMessages by default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVO Portlet Edit area, set the 
configuration options. At a minimum, specify the correct values for the 
following options:

• OVO Server

• Ack/Own Operator Login

• Ack/Own Operator Password (and Confirm Ack/Own Operator 
Password)

• Priority of Filter Assignments

4 On the Message Categories tab of the OVO Portlet Edit area, select the 
message categories to display.

5 On the Message Properties tab of the OVO Portlet Edit area, make any 
desired changes.

6 Click Save.



54 Chapter 3

HP Operations Dashboard Operations View Integration Guide: OVO and OVSN Version 2.10

Using the Messages Portlet

Use the Operations Messages portlet to display OVO messages through 
Operations View. Each message within the OVO message database has five 
standard OVO message attributes. The Messages portlet can be configured to 
group and display messages based upon any or all of these five standard 
attribute categories:

• Applications

• Message Groups

• Nodes

• Objects

• Services

Each message category displays a list of the OVO database elements in that 
attribute category, along with the number of messages received within each 
severity level for that element. Drilling down through any of the summary 
page links opens the list page that presents an overview of each message 
included in the category's summarized total.

Click on any link to display details about the received messages, such as: date, 
time, source of the message, message description, and any custom message 
attributes you configured.

Figure 5 shows an example of the Messages portlet.

You can further narrow down which messages are displayed in the Messages 
portlet by creating filters (see Filtering the OVO and OVSN Data for more 
information).
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Figure 5 Deployed Messages Portlet
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Customizing the Messages Portlet

You can modify the Operations Messages portlet in your portal view:

1 Access the portal view by logging on to the portal as a user with access to 
edit portlet preferences.

The portlet must also have the EDIT mode enabled.

2 In the title bar of the Messages portlet, click the edit button.

3 Make any desired changes. Click the help button for specific instructions:

• Choose the message categories to be displayed in this portlet 
(Applications, Message Groups, Nodes, Objects, and/or Services). The 
messages displayed in the Messages portlet are only those messages 
received from either (union of): 

— Nodes that pass the node list of the filter assignment for the 
current user.

— Services that pass the service list of the filter assignment for the 
current user.

• Only one OVO management server communicates with a Messages 
portlet. This portlet instance gathers data from the first OVO 
management server listed in the Administrator Tool, unless you 
specify from which OVO management server to gather the data. 
Choose from the OVO management servers currently configured for 
communication with Operations View (see Chapter 2, Configuring the 
Operations View Connection to OVO and OVSN if you need to add 
one).

• Change the ownership filter. Only messages associated with the 
indicated owners are displayed in this portlet.

• Select a different data filter.

• Choose the message categories to be displayed within the Messages 
portlet (Applications, Message Groups, Nodes, Objects, and/or 
Services). The messages displayed in the Messages portlet are only 
those messages received from either (union of):

— Nodes that pass the node portion of the filter assignment 
associated with the current portal role.
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— Services that pass the service portion of the filter assignment 
associated with the current portal role.

• Add or remove message categories to be displayed in this portlet.

• Change the display order of message categories.

4 Click OK to save the changes and return to the main portal page.

5 View the portal page to ensure that you have the desired results.
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Editing OVO Message Categories

Each message category for the Operations Messages portlet must be based 
upon one of the standard five OVO message categories:

• Applications

• Message Groups

• Nodes

• Objects

• Services

Operations View provides a simple message category definition file for each of 
the five standard OVO message categories. You can add, delete, and modify 
message categories by using the Administrator Tool. Each Operations View 
message category must be defined in the Administrator Tool before being 
displayed in Messages portlets. For more information, see:

• Message Category Configuration on page 59

• Filtering Within a Message Category on page 59

• Modifying An Existing Message Category on page 62

• Deleting a Message Category on page 63

• Deleting a Message Category on page 63
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Message Category Configuration

The choices explained in this section are specified in each message category 
definition.

Messages that pass the filter assignment (see Chapter 8, Filtering the OVO 
and OVSN Data) and the filter defined for the message category (see Filtering 
Within a Message Category on page 59) are further filtered by the following 
configuration as an AND condition before being displayed in any Messages 
portlet:

• ID: Required. The name of this message category. This name is used as a 
reference for displaying the category in the Messages portlet.

• Title: Required. The text that appears in the title bar of the message 
category when displayed within any instance of the Messages portlet and 
displayed in the OVO Categories selection list on the portlet edit page.

• Older Than X Minutes: Optional. Filters out the newer messages.

• Newer Than X Minutes: Optional. Filters out the older messages.

• Show Details: Optional. Specifies whether “detail” links are displayed for 
each message in the list page of the Messages portlet. This link provides 
access to additional information about the message.

• Display Count: Optional. Specifies the maximum number of messages 
that are displayed in the list page.

• Filtering for Category: Required. Specifies which one of the five OVO 
database attributes is used for grouping and displaying messages in this 
category: Service Selection, Node Selection, Message Group Selection, 
Object Selection, or Application Selection.

Filtering Within a Message Category

A filter is required for each individual message category. This filter actually 
determines which of the five standard message attributes are used to sort the 
message category. The messages displayed in the Messages portlet result from 
the intersection of the filter assignment and the filter from the category. It is 
possible at runtime for the intersection of these lists to be the empty set. In 
this case, no messages are output for the message category. (See Chapter 8, 
Filtering the OVO and OVSN Data for information about filter assignments 
and the simple customer model.)
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The filtering possibilities for message categories include the following. Only 
one of these filters can be used per OVO message category definition:

• Application Filter: Passes only messages from specified applications (as 
defined within OVO).

— For example, the following application filter allows all applications to 
pass:

.*

— The following example allows application1, application2, and 
application3 to pass (application# values can be Perl5 regular 
expressions): 

(application1|application2|application3)

• Message Group Filter: Passes only messages from specified OVO message 
groups (as defined within OVO).

— For example, the following filter allows all groups to pass:

.*

— The following example allows 3 groups to pass (messageGroup# values 
can be Perl5 regular expressions):

(messageGroup1|messageGroup2|messageGroup3)

• Object Filter: Passes only messages from specified OVO objects.

— For example, the following object filter allows all objects to pass:

.*

— The following example allows object1, object2, and object3 to pass 
(object# values can be Perl5 regular expressions):

(object1|object2|object3)

— The following example allows objects that end with "mail" to pass:

(.*mail)
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• Service Filter: Passes only messages from the OVSN services specified by 
name and/or type (as defined within OVO). 

— For example, the following service filter allows all services to pass:

.*

— The following example allows service1, service2, and service3 to pass 
(service# values can be Perl5 regular expressions):

(service1|service2|service3)

— The following example allows services that begin with "exch_" to pass:

(exch_.*)

• Node Selection Filter: Passes messages from devices specified by 
hostname or capability, or can refer to an organization defined within the 
simple customer model.

If no filter is specified in the Administrator Tool, the node selection filter 
allows all nodes to pass.

The following node selection filter example passes all nodes that meet all 
three criteria:

— Any node specifically listed in the IPHost Filter:

15\.2\.5\.125

15\.2\.6\.254

eagle\.wingnuts\.com

hawk\.wingnuts\.com

— That has the isServer capability or is currently in a critical state (the 
capability filter commonly refers to the capability field within the 
NNM database, with values such as isRouter or isNode. However, this 
filter can search upon any field in the NNM database):

field="IPStatus" value="Critical"

field ="isServer"
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— And any node that is included in OrganizationOne or 
OrganizationTwo definition:

OrganizationOne

OrganizationTwo

Modifying An Existing Message Category

To modify an OVO message category, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the HP OpenView Operations folder, expand 
the Message Categories folder, and then select the message category to 
modify.

The editor pane displays the configuration for the selected message 
category.

2 Configure the message category as desired (see Message Category 
Configuration on page 59 for information), and then click Save.

3 In a web browser, log in to the portal to verify that the message categories 
appear as desired.

When you specify more than one filter (IPHost Filter, Capability Filter, or 
Organization Filter), they are AND'd together. That is, messages must pass 
all filtering to be displayed, not just a single criterion.

When writing filters, use Perl5 regular expressions. For 
example:.*\.eagle\.wingnuts\.com

See http://www.perl.com or http://perldoc.perl.org for information about 
Perl5 regular expressions.

http://www.perl.com
http://perldoc.perl.org/
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Creating A New Message Category

Operations View ships with predefined message category configurations for 
the five standard OVO message categories. To create multiple versions of the 
same message category, each with unique configuration settings, follow these 
steps:

1 In the Administrator Tool, click File→ New→ OVO Message Category.

2 In the Add New OVO Message Category window, type the ID and file 
name of the new message category.

The editor pane displays the configuration for the new message category.

3 Configure the message category as desired (see Message Category 
Configuration on page 59 for information), and then click Save.

4 In a web browser, log in to the portal to verify that the message categories 
appear as desired.

Deleting a Message Category

To remove a message category, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the HP OpenView Operations folder, and 
then expand the Message Categories folder.

2 Right-click the name of the message category to delete, and then click 
Delete OVO Message Category.

You can choose to retain the message category configuration file for later 
use. This message category is no longer allowed to display in portal views, 
even if it is specifically listed in a Messages portlet.

3 In a web browser, log in to the portal to verify that the message categories 
appear as desired.

4 To completely remove any trace of this Operations View message category:

a Eliminate the category from all default portlet preferences, using the 
Administrator Tool to locate and correct all Messages portlet 
configurations.
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b Access the portal and find wherever the default portlet preferences 
have been customized and correct their settings by using the portlet 
edit pages.
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Establishing Global Settings for Messages Portlets

There are global settings that affect all message categories in every instance 
of a Messages portlet.

OVO Management Server Settings (UNIX Only)

Configuration settings for each OVO management server are entered onto the 
OVO tab of the Management Stations configurations in the Administrator 
Tool. A few settings for the OVOU management servers have a global affect on 
all instances of the Messages portlet communicating with an OVOU 
management server. These settings are useful when troubleshooting issues 
and tuning performance:

• Minimum Connections

The minimum number of connections to store in a pool shared by all 
Messages portlet instances when connecting to Oracle.

• Maximum Connections

The maximum number of connections to store in a pool shared by all 
Messages portlet instances when connecting to Oracle.

• Maximum Cached Statements

The maximum number of statements to cache in the Messages portlet.

See the online help within the Administrator Tool for more information.



66 Chapter 3

HP Operations Dashboard Operations View Integration Guide: OVO and OVSN Version 2.10

Advanced Topic: OVOConfig.xml/dtd

The following is an example of the possible settings in the XML file 
OVOConfig.xml, and involves working with XML files. Making changes to this 
file should only be done by those comfortable making changes to XML files 
and applies to all OVO Messages portlets:

<OVOModuleConfig 
      labelCacheRefresh="60"
      messageDisplayCount="50"

      editStyle="ovoEdit"
      summaryStyle="ovo"
      listStyle="ovo"
      detailStyle="ovo"
/>

The following attributes control the behavior of all Messages portlets:

• labelCacheRefresh (zero or greater): The number of minutes to wait before 
retrieving label values for MessageGroups, Nodes, and Services from the 
OVO database. Labels are retrieved for display within the Messages 
portlet. If no label can be found, the value in the id field is used until the 
next refresh cycle.

• messageDisplayCount (zero or greater): The default number of messages 
to show in the message list page. This can be overridden for a particular 
category by setting the displayCount attribute within a message category 
definition file.

The following style-related attributes are provided for backwards 
compatibility. They are no longer used and have no impact:

• summaryStyle

• listStyle

• detailStyle

• editStyle

See the comments in the OVOConfig.dtd and OVOConfig.xml files for more 
information.
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To modify the OVOConfig.xml file, follow these steps:

1 Make a backup of the XML file before you make changes. If you edit the 
XML file and get incorrect XML syntax, you might want to revert to the 
previous version of the file.

2 Before you start, access the following file as a reference:

• Windows: <data_dir>\conf\dashboard\opview\share\
portlet-config\ovo\OVOConfig.dtd

• UNIX: /var/opt/OV/conf/dashboard/opview/share/
portlet-config/ovo/OVOConfig.dtd

3 In an ASCII or XML editor, open the OVOConfig.xml file, stored in the 
same location as the OVOConfig.dtd file.

4 Make your changes and save the file.

5 Validate the syntax of your XML files. Refer to the Operations View 
Administrator Guide for information on the ovopviewxmlvalidate tool 
provided with Operations View.

6 Log in to the portal as the appropriate user to ensure that you have the 
desired results.
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4 Working with the Service Browser Portlet

HP OpenView Dashboard Operations View provides the Service Browser 
portlet for integrating with HP OpenView Service Navigator (OVSN).

This chapter describes how to create, configure, use, and customize the 
Service Browser portlet. For an overview of the portlet’s functionality, see 
Chapter 1, Introduction to the OVO and OVSN Integrations.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Service 
Browser Portlet on page 70.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Service Browser Portlet on 
page 71.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Service Browser Portlet on page 74.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Service Browser Portlet on page 76.
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Creating the Service Browser Portlet

Use the Administrator Tool to create the Service Browser portlet within an 
existing portlet application.

To create the Service Browser portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVSNBrowser from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Service Browser Portlet

For information on the Service Browser portlet configuration options, click 
Help at the bottom of the editor pane to view the online help page.

To configure the default settings for the Service Browser portlet, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Service Browser portlet (named OVSNBrowser by 
default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVSN Card Browser Portlet Edit 
area, set the configuration options. At a minimum, specify the correct 
values for the following options:

• Service Navigator System

• Priority of Filter Assignments

If HP OpenView Interconnect (OVI) is configured, also specify the correct 
values for the following options:

• Ack/Own Operator Login

• Ack/Own Operator Password (and Confirm Ack/Own Operator 
Password)

4 On the Services tab of the OVSN Card Browser Portlet Edit area, select 
the services to monitor.

5 Click Save.
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Using the Service Browser Portlet

The Service Browser portlet displays a list of the top-level services or selected 
services currently defined in OVSN. To quickly locate and display a particular 
service or child service, use the search feature. The order of services can be 
easily changed by clicking the column title:

• Sort by Status column

The first column on the left tells you how healthy your service currently is 
by displaying the current status. The status ranges from normal to 
warning, minor, major, and critical. Appendix A, Service Status describes 
the meaning of each color and gives a detailed explanation of each status. 
Click on this column title to sort the table by status.

Clicking on the status icon in this column might or might not display the 
defined service properties (such as actions, propagation rules, and 
calculation rules as defined within OVSN). Access to service properties is 
configurable. By default, access to service details is disabled. 

• Sort by Label column

The second column from the left displays the label of the service. Click on 
this column title to sort the table by label. Clicking on an underlined 
service label displays the Service Browser with a list of the child services 
of this service.

• Sort by Description column

The third column from the left displays a description of the service. Click 
on this column title to sort the services by description.

Figure 6 shows an example of the Service Browser portlet.

Figure 6 Deployed Service Browser Portlet
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The Service Browser portlet includes the following features:

• Search box.

To use the search feature, type a string in the Search box, and then click 
Submit.

The search tool searches all service labels. Text strings in lowercase match 
words in any case. Search terms can be complete words, syllables, or 
single letters.

The search results in a list of all services whose label or name matches the 
search term.

• Service table.

The actual number and selection of services displayed in the Service 
Browser portlet depends upon the configuration settings of the Service 
Browser portlet (see Customizing the Service Browser Portlet on page 76) 
and the configuration of filtering for the current filter assignment (see 
Chapter 8, Filtering the OVO and OVSN Data for information about 
filtering).
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Customizing the Service Browser Portlet

You can modify the Service Browser portlet in your portal view:

1 Access the portal view by logging on to the portal as a user with access to 
edit portlet preferences.

The portlet must also have the EDIT mode enabled.

2 In the title bar of the Service Browser portlet, click the edit button.

3 Make any desired changes.

• Only one OVO/OVSN management server communicates with any 
Service Navigator portlet. This portlet instance gathers data from the 
first OVO management server listed in the Administrator Tool, unless 
you specify from which OVO management server to gather the data. 
Choose from the OVO management servers currently configured for 
communication with Operations View (see Chapter 2, Configuring the 
Operations View Connection to OVO and OVSN if you need to add 
one).

• To allow access to service properties (such as actions, propagation 
rules, and calculation rules as defined within OVSN), select the Allow 
Details View Drill-down check box.

• Choose the services to be displayed within the Service Browser portlet 
(either all top-level services or selected services). 

To select specific services, use SHIFT+CLICK or CTRL+CLICK to move 
groups of services from side to side. Only those services that pass the 
service list of the filter assignment used by the current portal user are 
displayed.

• Remove a service from the Service Browser portlet’s displayed list.

• Change the display order of selected services.

4 Click OK to save the changes and return to the main portal page.

5 View the portal page to ensure that you have the desired results.
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5 Working with the Service Cards Portlet

HP OpenView Dashboard Operations View provides the Service Cards portlet 
for integrating with HP OpenView Service Navigator (OVSN).

This chapter describes how to create, configure, use, and customize the 
Service Cards portlet. For an overview of the portlet’s functionality, see 
Chapter 1, Introduction to the OVO and OVSN Integrations.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Service Cards 
Portlet on page 78.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Service Cards Portlet on 
page 79.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Service Cards Portlet on page 82.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Service Cards Portlet on page 84.
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Creating the Service Cards Portlet

Use the Administrator Tool to create the Service Cards portlet within an 
existing portlet application.

To create the Service Cards portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVSNCards from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Service Cards Portlet

For information on the Service Cards portlet configuration options, click Help 
at the bottom of the editor pane to view the online help page.

To configure the default settings for the Service Cards portlet, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Service Cards portlet (named OVSNCards by default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVSN Card Browser Portlet Edit 
area, set the configuration options. At a minimum, specify the correct 
values for the following options:

• Service Navigator System

• Priority of Filter Assignments

If HP OpenView Interconnect (OVI) is configured, also specify the correct 
values for the following options:

• Ack/Own Operator Login

• Ack/Own Operator Password (and Confirm Ack/Own Operator 
Password)

4 On the Services tab of the OVSN Card Browser Portlet Edit area, select 
the services to monitor.

5 Click Save.
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Using the Service Cards Portlet

Service cards show at a glance the most important information about a 
service. You can drill down to details about each service or to any of the child 
services. To quickly locate and display a particular child service, use the 
search feature on the details window.

The number and selection of service cards depends upon the configuration 
settings of the Service Cards portlet (see Customizing the Service Cards 
Portlet on page 84) and the configuration of filtering for the current portal 
user (see Chapter 8, Filtering the OVO and OVSN Data for information about 
filtering).

Figure 7 shows an example of the Service Cards portlet.

Figure 7 Deployed Service Cards Portlet
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The Service Cards portlet includes the following features:

• Title label of the service
Above the service icon, the title label of the service is displayed. If you 
click the icon, a Service Browser opens, displaying all children of the 
service. See Using the Service Cards Portlet on page 82.

• Icon of the service
The color of the icon indicates the current status of the service. See 
Appendix A, Service Status for a description of the meaning of each color.

If you click the icon, the details of the Service Properties (such as actions, 
propagation rules, and calculation rules as defined within OVSN) are 
displayed.

Access to service details can be configured in portlet preferences. By 
default, user access to service details is enabled.

• Description of the service
Below the icon, a description of the service is displayed. If no description is 
available, this is indicated as well.

• Label of the service
To the right of the icon, the label of the service is displayed.

• Status of the service
To the right of the icon, below the label of the service, the current status of 
the service is indicated.



84 Chapter 5

HP Operations Dashboard Operations View Integration Guide: OVO and OVSN Version 2.10

Customizing the Service Cards Portlet

The Service Cards portlet lets you add individual services in a business card 
format. 

You can modify the Service Cards portlet in your portal view:

1 Access the portal view by logging on to the portal as a user with access to 
edit portlet preferences.

The portlet must also have the EDIT mode enabled.

2 In the title bar of the Service Cards portlet, click the edit button.

3 Make any desired changes. Click the help button for specific instructions:

• Only one OVO management server communicates with any Service 
Navigator portlet. This portlet instance gathers data from the first 
OVO management server listed in the Administrator Tool, unless you 
specify from which OVO management server to gather the data. 
Choose from the OVO management servers currently configured for 
communication with Operations View (see Chapter 2, Configuring the 
Operations View Connection to OVO and OVSN if you need to add 
one).

• To allow access to service properties (such as actions, propagation 
rules, and calculation rules as defined within OVSN), select the Allow 
Details View Drill-down check box.

• Choose the services to be displayed as business card graphics within 
the portlet (either all top-level services or selected services).

To select specific services, use SHIFT+CLICK or CTRL+CLICK to move 
groups of services from side to side. Only those services that pass the 
service list of the filter assignment used by the current portal user are 
displayed.

• Remove a service from the Service Cards portlet’s displayed list.

• Change the display order of selected services.

4 Click OK to save the changes and return to the main portal page.

5 View the portal page to ensure that you have the desired results.
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6 Working with the Service Graph Portlet

HP OpenView Dashboard Operations View provides the Service Graph portlet 
for integrating with HP OpenView Service Navigator (OVSN).

This chapter describes how to create, configure, use, and customize the 
Service Graph portlet. For an overview of the portlet’s functionality, see 
Chapter 1, Introduction to the OVO and OVSN Integrations.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Service Graph 
Portlet on page 86.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Service Graph Portlet on 
page 87.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Service Graph Portlet on page 90.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Service Graph Portlet on page 92.
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Creating the Service Graph Portlet

Use the Administrator Tool to create the Service Graph portlet within an 
existing portlet application.

To create the Service Graph portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVSNServiceGraph from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Service Graph Portlet

For information on the Service Graph portlet configuration options, click Help 
at the bottom of the editor pane to view the online help page.

To configure the default settings for the Service Graph portlet, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Service Graph portlet (named OVSNServiceGraph by 
default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVSN Graph Portlet Edit area, set 
the configuration options. At a minimum, specify the correct values for the 
following options:

• Service Navigator System

• Priority of Filter Assignments

If HP OpenView Interconnect (OVI) is configured, also specify the correct 
values for the following options:

• Ack/Own Operator Login

• Ack/Own Operator Password (and Confirm Ack/Own Operator 
Password)

4 On the Services tab of the OVSN Graph Portlet Edit area, select the 
services to monitor.

5 Click Save.
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Using the Service Graph Portlet

The Service Graph portlet displays the OVSN service hierarchy in a graphical 
view. Service Graph also provides drill-down capability. You can click on any 
service to get a summary view of child services. To select a Service Graph, 
select a graph from the Choose a Service Graph box at the top of the Service 
Graph portlet.

The number and selection of available graphs depends upon the configuration 
settings of the Service Graph portlet (see Customizing the Service Graph 
Portlet on page 92) and the configuration of filtering for the current portal 
user (see Chapter 8, Filtering the OVO and OVSN Data for information about 
filtering).

Figure 8 shows an example of the Service Graph portlet.

If there are more than 200 nodes in the selected service’s hierarchy, the graph 
is automatically limited to a depth of three child-service layers.
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Figure 8 Deployed Service Graph Portlet
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Customizing the Service Graph Portlet

The Service Graph portlet provides a graphical view of the service hierarchy.

You can modify the Service Graph portlet in your portal view:

1 Access the portal view by logging on to the portal as a user with access to 
edit portlet preferences.

The portlet must also have the EDIT mode enabled.

2 In the title bar of the Service Graph portlet, click the edit button.

3 Make any desired changes. Click the help button for specific instructions:

• Only one OVO management server communicates with any Service 
Navigator portlet. This portlet instance gathers data from the first 
OVO management server listed in the Administrator Tool, unless you 
specify from which OVO management server to gather the data. 
Choose from the OVO management servers currently configured for 
communication with Operations View (see Chapter 2, Configuring the 
Operations View Connection to OVO and OVSN if you need to add 
one).

• Choose the services to be displayed within the Service Graph portlet 
(either all top-level services or selected services).

To select specific services, use SHIFT+CLICK or CTRL+CLICK to move 
groups of services from side to side. Only those services that pass the 
service list of the filter assignment used by the current portal user are 
displayed.

• Remove a service from the Service Graph portlet’s displayed list.

• Change the display order of selected services.

• Set the display depth for services.

4 Click OK to save the changes and return to the main portal page.

5 View the portal page to ensure that you have the desired results.

Editing the portlet from your portal versus editing the portlet default 
preferences has a unique difference. The Administrator Tool allows you to set 
image sizes for the graph in default portlet preferences.
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Additional Information Regarding the Service Graph Depth Setting

You can optionally specify how many of child-service levels (depth) to display 
in the graph. The depth is the number of child-service levels within the OVSN 
hierarchy that are allowed to display in your Operations View portlet. The 
depth value always indicates depth starting from level 2. For example: 

• (Default) Depth of 0 stands for recursive and means that the portlet is 
allowed to display all service information.

• Depth of 1 means that the portlet is allowed to display service information 
from levels 1 and 2.

• Depth of 7 means the portlet is allowed to display service information 
from levels 1, 2, 3, 4, 5, 6, 7, and 8.

Figure 9 Deciding Upon the Child-Service Depth Setting

If there are more than 200 nodes in the selected service’s hierarchy, the graph 
is automatically set at depth=3, three child-service layers.

1
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Level DepthService Hierarchy

Depth 0 = recursive, all levels including top level services

1

2

Top-Level Services

Child-Service Levels

Up to 256
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7 Working with the Service Health Portlet

HP OpenView Dashboard Operations View provides the Service Health 
portlet for integrating with HP OpenView Service Navigator (OVSN).

This chapter describes how to create, configure, use, and customize the 
Service Health portlet. For an overview of the portlet’s functionality, see 
Chapter 1, Introduction to the OVO and OVSN Integrations.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Service 
Health Portlet on page 96.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Service Health Portlet on 
page 97.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Service Health Portlet on page 100.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Service Health Portlet on page 102.
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Creating the Service Health Portlet

Use the Administrator Tool to create the Service Health portlet within an 
existing portlet application.

To create the Service Health portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVSNSvcHealth from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Service Health Portlet

For information on the Service Health portlet configuration options, click Help 
at the bottom of the editor pane to view the online help page.

To configure the default settings for the Service Health portlet, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Service Health portlet (named OVSNSvcHealth by 
default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVSN Health Portlet Edit area, set 
the configuration options. At a minimum, specify the correct values for the 
following options:

• Service Navigator System

• Priority of Filter Assignments

If HP OpenView Interconnect (OVI) is configured, also specify the correct 
values for the following options:

• Ack/Own Operator Login

• Ack/Own Operator Password (and Confirm Ack/Own Operator 
Password)

4 On the Gauges tab of the OVSN Health Portlet Edit area, configure the 
list of gauges to be displayed in the portlet.

5 On the Gauge Edit tab of the OVSN Health Portlet Edit area, make any 
desired changes.

6 Click Save.
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Using the Service Health Portlet

The Service Health portlet displays gauges measuring the percentage of 
services in a particular state (health status) or set of states. Service health is 
scored as a percentage from 0-100.

Figure 10 shows an example of the Service Health portlet. Depending upon 
how the Service Health portlet is configured, you might see one or more 
gauges, with each gauge presenting different data.

Figure 10 The Service Health Gauges
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The Service Health portlet provides access to the following:

• The gauges indicate the percentage of all services being monitored that 
fall into the configured status category or categories. (See Appendix A, 
Service Status for an explanation of the status categories.)

For example:

— The first gauge in Figure 10 is measuring the percentage of all 
services that currently report normal status (operating as expected). 
The high reading of 83.15% means that your service environment is 
healthy; a high reading here is good. The scale used by the gauge is:

– 0-40% = red/bad

– 41-80% = yellow/warning 

– 81-100% = green/good 

— The second gauge in Figure 10 on page 100 is measuring the 
percentage of all services that currently report critical status 
(immediate corrective action required). The low reading of 3.37% 
means that a small number of services are probably not available at 
this time; a low reading here is good. The scale used by the gauge is:

– 100-60% = red/bad 

– 61-20% = yellow/warning 

– 19-0% = green/good 

• The gauge title is a link. Click the title to display details about what is 
being measured. For example, if the gauge is monitoring all services 
currently reporting a critical status, a list of all critical services is 
displayed.

• The gauge icon is a link. Click the gauge icon to display details about each 
possible status and how many services are currently reporting each 
status. (See Appendix A, Service Status for an explanation of the status 
categories.)
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Customizing the Service Health Portlet

The Service Health portlet shows calculated service health in a gauge-like 
view.

You can modify the Service Health portlet in your portal view:

1 Access the portal view by logging on to the portal as a user with access to 
edit portlet preferences.

The portlet must also have the EDIT mode enabled.

2 In the title bar of the Service Health portlet, click the edit button.

3 Make any desired changes. Click the help button for specific instructions:

• Only one OVO management server communicates with any Service 
Navigator portlet. This portlet instance gathers data from the first 
OVO management server listed in the Administrator Tool, unless you 
specify from which OVO management server to gather the data. 
Choose from the OVO management servers currently configured for 
communication with Operations View (see Chapter 2, Configuring the 
Operations View Connection to OVO and OVSN if you need to add 
one).

• To allow access to service properties (such as actions, propagation 
rules, and calculation rules as defined within OVSN), select the Allow 
Details View Drill-down check box.

• Create new health gauges to be displayed within the Service Health 
portlet. Click Add to advance to the Service Health Gauge 
Configuration page. Click the help button for specific instructions. For 
each gauge, you can select the following:

— Title: Enter or modify the title for your Service Health Gauge. 
This is the text that appears at the top of the gauge.

— Score Name: Enter a description of the score. This is the text that 
appears to the left of the percent (%) result at the bottom of the 
gauge. For example, if you type in "Normal", the results might be 
Normal: 83.7%

— Follow Service Tree Recursively: Controls how many levels of the 
tree are included in this gauge's calculation. A tree configuration 
of services and subservices is configured in your OVSN database.
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If selected, all subservices (all levels of the tree) under any 
specified service are included in the calculation. Each service must 
pass the current filter assignment. 

If not selected, only the specified services and their immediate 
child services are included in the gauge's calculation (one layer 
deep). 

— Invert calculation: If a high percentage score is a bad thing, select 
this item. This setting controls which way the needle moves across 
the gauge.

If selected, the "inverted" scale is: 

100-60% = red/bad 

61-20% = yellow/warning 

19-0% = green/good 

If not selected, the normal (not inverted) scale is: 

0-40% = red/bad

41-80% = yellow/warning 

81-100% = green/good 

— In the Service State Selection list, select the status settings (as 
received from OVSN) that should contribute toward this health 
calculation. For example, if you select Critical and Major, a 
resulting score of 5% means that 5% of your services are either in 
a critical or major state. 

— In the Gauge - Service Selection section: Select either for the 
gauge's calculation:

Use all top-level services: To include all top-level services that 
pass the current filter assignment.

Use selected services: To specify a subset of services. Select 
services in the list and click Add Service and Remove Service until 
the Selected Services list contains all the services you want to 
include in this gauge's calculation formula. The selected services 
must pass the current filter assignment.
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• Modify an existing health gauge. Select the gauge title, and then click 
Modify to advance to the Service Health Gauge Configuration page. 
Click the help button for specific instructions, or see the information 
for adding a new service gauge for specific settings.

• Remove a service from the Service Health portlet’s displayed list.

• Change the display order of selected services.

4 Click OK to save the changes and return to the main portal page.

5 View the portal page to ensure that you have the desired results.
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8 Filtering the OVO and OVSN Data

The HP OpenView Dashboard Operations View customer model allows you to 
associate resources (nodes and services) with organizations. These 
organizations are associated with portlets and portal users so that data is 
automatically filtered appropriately when a user displays any of the Messages 
or Services Navigator portlets. This process is required to enable the OVO/
OVSN portlets.

Before you proceed, decide for which groups you need to filter data. For 
example, you might need to provide portals for several divisions within your 
company: accounting, marketing, R&D, legal, support. You could create node 
and service lists of the resources assigned to each of these organizations. 
Because of the assigned resource lists, each of these organizations could view 
the same instance of the Messages or Service Navigator portlets, yet see only 
the data appropriate for them.

The remainder of this chapter explains how to create node lists and service 
lists for use in your organizations.

The Messages portlet responds to both node lists and service lists. The 
Messages portlet displays any data that passes either the node or service list 
(the union of the two sets). Service Navigator portlets respond only to service 
lists:

• Node List elements 
In the OVO message database, there is a node field and a source node 
field. The Operations View node list definitions key off of the node field.

An even finer level of data control is available at the portlet-type or 
portlet-instance level. This finer level of control determines what the user 
actually sees in a particular portlet. For more information, see the chapter for 
each portlet. You can combine the Operations View customer model with this 
filtering to achieve the desired results in the Messages portlet and the Service 
Navigator portlets.
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• Service List elements
If HP OpenView Service Navigator (OVSN) is installed and configured on 
your OVO/OVSN management server, the Operations View service list 
definitions key off of the currently defined services.

Your node lists and service lists can be defined in one or more customer model 
sources:

• Manually Creating Node List and Service List Filters on page 107

• Customer-to-Node Mappings on page 107

• Customer-to-Service Mappings on page 109

Operations View provides several tools that simplify the process of defining 
node lists by gathering the required data from the NNM object database (a 
component of OVO). If these tools might be useful in your particular situation, 
refer to the data filtering chapter in the Operations View Integration Guide: 
NNM.

You can also create your own program to generate your node lists and/or 
service lists from a data store or provisioning system, and express it in XML 
that conforms to the SimpleCustomerModel.dtd. Refer to the information on 
custom customer model sources in the Operations View Administrator Guide.



Filtering the OVO and OVSN Data 107

Version 2.10 HP Operations Dashboard Operations View Integration Guide: OVO and OVSN

Manually Creating Node List and Service List Filters

The Operations View customer model allows you to associate lists of resources 
with organizations. This section explains how to create lists of nodes and lists 
of services specifically for use with the Messages and Service Navigator 
portlets. You can use one customer model source that contains all of your node 
lists and service list filters, or you can create customer model sources, each 
containing one of more of these filters. Your lists can be directly inserted into 
your organization definitions or inserted by reference

Customer-to-Node Mappings

To create node list filters that are associated with an organization in your 
customer model, do the following. These node list filters control which 
messages are displayed in the Messages portlet.

The Operations View portlets that communicate with HP OpenView Network 
Node Manager (NNM) also are affected by this node list. See the Operations 
View Integration Guide: NNM for more information:

• Alarms portlet

• Network Device Health portlet

• Topology portlet
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Determining Which Nodes to Add to the Customer Model

If you do not already know the fully-qualified hostname or IP address of the 
nodes to include in the node list filters, follow the steps appropriate to the 
OVO operating system to gather that information.

On the OVO for UNIX Management Server:

1 As root, run the /opt/OV/bin/OpC/utils/opcnode command to get a list 
of current node values in the OVO database:

opcnode -list_nodes

The following is an example of the output generated by this command for 
one database node value:

List of all Nodes in the ITO database:
====================================================================
Name         = serverName.div.co.com
Label        = serverName
IP-Address   = 192.168.1.1
Network Type = MACH_S400, NETWORK_IP, CONSOLE_TEMPLATE, COMM_NCS
Machine Type = MACH_HP11_PA_RISC
Comm Type    = MACH_S800, COMM_DCE_UDP
====================================================================
Operation successfully completed.

2 To list all nodes assigned to a specific group, run:

opcnode -list_ass_nodes group_name=xx

See the opcnode.1m manpage for more information.

3 Use this information when creating the node list filters on the Operations 
View server.

On the OVO for Windows Management Server

To establish communication between OVO and Operations View, you followed 
steps in Chapter 2, Configuring the Operations View Connection to OVO and 
OVSN to install an application called ovow2sip.aspx onto the OVOW 
management server. You can use this application to generate a list of nodes.

1 From a web browser on the OVOW management server, run the 
ovow2sip.aspx application as follows:

http://ovowserver/ovow2sip.NET/ovow2sip.aspx?query=ListNodes
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2 Use this information when creating the node list filters on the Operations 
View server.

Adding Node Lists to the Customer Model

To create a node list filter, do the following steps on the Operations View 
server:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, expand the appropriate 
customer model source, and then select the organization to modify.

Alternatively, click File→ New→ Organization to create a new organization 
for this node list filter.

The editor pane displays the configuration for this organization. On the 
Nodes tab, you can work with the organization’s default node list, create a 
new node list, remove an existing node list, or refer to a named node list 
defined elsewhere in your customer model sources.

2 Optional: Create a node list with a name that you can reference later 
when you are assigning node lists to a specific organization.

3 Required: For each node in this list, enter a fully-qualified hostname or IP 
address into the Name field.

4 Click Save.

You are now ready to associate these node list filters with other organizations 
in your customer model. You can also set up filter assignments to specify the 
portal users to which the organization applies. Refer to Chapter 12, 
Configuring Operations View Data Filters in the Operations View 
Administrator Guide for information.

Customer-to-Service Mappings

If OVSN is installed and configured on your OVO/OVSN management server, 
you must create a service list filter within each organization to enable the 
Service Navigator portlets.

HP recommends that you include only top-level services in your service lists. 
For each top-level service, you then specify the allowable depth (up to a 
maximum of 256 child-service levels).
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Figure 11 Deciding Upon the Child-Service Depth Setting

The depth is the number of child-service levels within the OVSN hierarchy 
that are displayed in the Service Navigator portlet. The depth value always 
indicates depth starting from level 2. For example:

• Depth of 0 or unset: Recursive. The Service Navigator portlets display all 
service information.

• Depth of 1: The Service Navigator portlets display service information 
from levels 1 and 2.

• Depth of 7: The Service Navigator portlets display service information 
from levels 1, 2, 3, 4, 5, 6, 7, and 8.

Determining Which Services to Add to the Customer Model

If you do not already know the names of the services that you want to include 
in your server list filters, follow the steps appropriate to the OVO operating 
system to gather that information.

1
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Level DepthService Hierarchy

Depth 0 = recursive, all levels including top level services
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Up to 256
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On the OVO for UNIX Management Server:

As root, run the following commands to generate lists of currently configured 
services:

• To generate a list of top-level services, run this command (in /opt/OV/
bin/OpC/): 
opcservice -list

The following is an example of the output generated by this command:

Service: clusterapps
Service: email
Service: geo_orga

• To generate a list of all services (top-level and child services), run this 
command (in /opt/OV/bin/OpC/):
opcservice -list -recursive | grep Service: > filename

Use this information when creating the service list filters on the Operations 
View server.

On the OVO for Windows Management Server

To establish communication between OVO and Operations View, you followed 
steps in Chapter 2, Configuring the Operations View Connection to OVO and 
OVSN to install an application called ovow2sip.aspx onto the OVOW 
management server. You can use this application to generate a list of services.

1 From a web browser on the OVOW management server, run the 
ovow2sip.aspx application as follows:

http://ovowServer/ovow2sip.NET/
ovow2sip.aspx?query=ListServices

http://ovowServer/ovow2sip.NET/
ovow2sip.aspx?query=Listservices&includeDisplay=true

2 Use this information when creating the service list filters on the 
Operations View server.
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Adding Services to the Customer Model

To create a service list filter, do the following steps on the Operations View 
server:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, expand the appropriate 
customer model source, and then select the organization to modify.

Alternatively, click File→ New→ Organization to create a new organization 
for this node list filter.

The editor pane displays the configuration for this organization. On the 
Services tab, you can work with the organization’s default service list, 
create a new service list, remove an existing service list, or refer to a 
named service list defined elsewhere in your customer model sources.

2 Optional: Create a service list with name that you can reference later 
when you are assigning service lists to a specific organization.

3 Required: For each service in this list, enter service name as defined in the 
OVSN database into the Name field.

4 Optional: Specify the depth for each service specification. Depth controls 
how many child-service levels are displayed in the Service Navigator 
portlets. If no depth is specified, the default is zero (0). Valid entries are as 
follows:

0 (or empty): Recursive. All levels of child services in the service tree pass 
through.

1 - 256: A specific number of child-service levels in the service tree pass 
through.

5 Optional: Specify the type for each service specification. This field is used 
by the Messages portlet and can be used for filtering within categories 
defined as service categories.

6 Optional: Specify a display string for each service specification. The 
display string appears as the service name in the Service Navigator 
portlets.

7 Click Save.

You are now ready to associate these service list filters with other 
organizations in your customer model. You can also set up filter assignments 
to specify the portal users to which the organization applies. Refer to the 
Operations View Administrator Guide for information.
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A Service Status

Table 6 describes the meaning of each severity color.

Table 6 Service Status

Status Color Meaning

Critical Red A service-affecting condition has occurred and immediate 
corrective action is required.

Major Orange The severity of the problem is relatively high and normal use of 
the object is likely to be impeded.

Minor Yellow A problem of relatively low severity has occurred, which should 
not impede normal use of the object.

Warning Cyan A potential or impending, service-affecting fault has occurred. 
Action should be taken to diagnose and correct the problem.

Normal Green Message output is expected: for example, a process is starting or 
completing, or status information is displayed.
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